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Phoenix User’s Guide

Introduction

This section briefly describes how to install Phoenix and includes some basic information 
on how to use the program.  More detailed information can be found in the Phoenix Help 
files.  Each feature in Phoenix has its own Help file, which can be activated whil running 
Phoenix.  To activate a Help file while Phoenix is running, press the F1 key or the specific 
feature’s Help button.

General Setup Procedure

Initial installation of Phoenix requires the complete Phoenix installation package.  This 
package, currently around 30 Megabytes in size, is provided on a CD-ROM disk.  Because 
of this large size, it is not recommended to download the file nor is it practical to provide 
it on 3.5-inch floppy disks.

Install Phoenix by following the steps outlined on the material that comes with the disk.  
It should be noted that installation of a Nokia dongle on the computer being loaded is 
REQUIRED prior to beginning the installation of the software.

The software is packaged into an Installshield executable bundle.  When the user double-
clicks on this file, the installation program provides on-screen instructions on how to 
proceed.  Standard installation, provided by selecting all default choices, is highly recom-
mended.  You may do a custom installation and place Phoenix into a special location on 
your hard drive, but this is only recommended for experienced users.

It is necessary to reboot the computer after installing the software.  The program will not 
be usable until a reboot is performed.  After reboot, the Phoenix icon is displayed on the 
computer desktop.  Double-clicking on this icon launches the program.
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Hardware Requirements for using Phoenix

Installing Phoenix

Before installing the software, verify:

• The dongle is attached to the parallel port for PKD version dongles, or an FLS-4 version 
dongle is attached on either the parallel port or the USB port (if the computer supports 
USB).

• Ensure that if the computer supports administrator rights (typically on Windows NT 
and Windows 2000 installations) that access is enabled for the user performing the 
Phoenix installation.

• If a previous version of Phoenix has been installed, it may be necessary to first properly 
remove that program prior to installing the new version.  If installation is performed, be 
sure to reboot the computer prior to continuing.  See the section Uninstalling Phoenix 
for instructions on how to uninstall.

Installation Directions

• Insert the CD-ROM disk into the computer drive

• Access the drive and double-click on the Phoenix software package found on the CD.

• Follow the on-screen prompts to conclusion.

Note that rebooting the computer may be necessary when completed.

Software Support Bundles:

The Phoenix installation is auto-executable.  You must obtain Software Support Bundles 
to load software upgrade files to customer-specific phone models.

Minimum Hardware Requirements

Processor 233 MHz

RAM 64 MB

Disk Space Needed 50-100 MB

Supported Operating Systems Notes

Windows 95 Limited, no USB support

Windows 98

Windows NT 4.0 no USB support

Windows 2000 Professional version 
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These bundles are created by PAMS and made available by AMS on the Partners Web 
Page http://americas.partners.nokia.com.  This web page is password-controlled; if you 
have not registered as a user, contact Nokia Central Service in Melbourne, Florida.

Similar to the Phoenix installation, these Software Support Bundles are InstallShield exe-
cutable packages.  Just double-click on the package and it will auto-install.  

No rebooting of the computer is required.

Starting a Phoenix Session

Concepts

When referring to Phoenix, Product is the cellular phone attached to the computer.  
More specifically, it is the particular type of phone.

Connection is the type of cable used to attach the phone and the port on the computer 
where it is attached. Refer to Chapter 7-Service Tools for additional information.

The first time Phoenix is used, certain connection configurations must be made.  Subse-
quent uses will rely on these selections and they will not need to be made again.

Initial Session with Phoenix

It is necessary to create the connection the first time Phoenix is used.  Follow these sim-
ple steps:  
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Select Manage Connections… from the “File” drop-down menu.

Next click the Add… button to create a new connection.

When the Select Mode dialog box appears, you may then select either Wizard, which will 
auto-detect your connection configuration, or Manual, which allows you to manually 
select options to create the connection.
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Once a connection is defined, make sure that the one to be used is moved to the top of 
the list (use the up down arrows on the Manage Connections dialog box.  Then click on 
the Apply button.  Close the window when finished.

You can now proceed with the normal initiation of a session by selecting a product or 
scanning for a product.

Scanning for a Product

Many features of this program are product-specific.  Therefore it is necessary to config-
ure Phoenix for the product  on which you will be working at the beginning of the ses-
sion. 

Scan Product – Choose Scan Product from the drop-down menu list and Phoenix will 
automatically scan for product and select the necessary configurations.  The status bar 
at the bottom will indicate if the product was found and its type.

Using Components

When working with Phoenix, tasks are generally managed by specific software compo-
nents.  From the menu, select the desired component or task to be performed.

“Opening a component” is defined as opening a tool window within Phoenix.  When this 
window is opened, Phoenix also opens a toolbar for it and adds component-specific 
menu items in the Window menu.

Using Profiles

Phoenix’s Profile feature allows product, connection and currently open components to 
be stored into permanent storage by creating a profile file with a name of your choice 
followed by an .nmp file extension for later retrieval.

Saved profiles makes it easy to configure Phoenix into a desired configuration with 
favorite windows already opened and ready to go.
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Opening and saving profiles is done via menu commands found in the File drop-down 
menu: Open Profile and Save Profile.

Profiles are stored into a disk file with user-defined names.  As a result, there can be 
multiple profiles for different repeated tasks or user preferences.

Uninstalling Phoenix

As mentioned in the Installing Phoenix section, it may be necessary or desirable to 
remove Phoenix.  Care must be taken to follow this procedure.  Failure to remove the 
program properly will cause misconfiguration of the computer’s registry.

Uninstalling Phoenix version:

• Access the computer’s “Control Panel” section,  selectable from the Start button or the 
“My Computer” desktop icon

• Select the “Add/Remove Programs” icon

• Select the Phoenix version to be removed, and click the Add/Remove button

• Click on the OK button to begin the process of removal

• Follow the on-screen instructions

Be sure to reboot the computer when finished. 
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Diego User’s Guide

Introduction

This section briefly describes how to install Diego 2.10 and includes some basic informa-
tion on how to use the program.  More detailed information can be found in the Diego 
Help files.  Each feature in Diego has a Help file that can be activated while running 
Diego.  To activate a Help file while Diego is running, press the F1 key or the specific fea-
ture's Help button.

Diego 2.10 is designed to be used by point-of-sales locations.  Ease of use and minimal 
operator decision-making were key factors in the design.  

Supported Phones

2270, 2272, 2285       3280, 3285        3570, 3585, 3585i     5170i, 5180i, 5185  6370, 6385                      

8270                    8280                6180i, 6185i  
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General Setup Procedure

Initial installation of Diego requires the complete Diego installation package.  This pack-
age, currently around 18 Megabytes in size, is provided on a CD ROM disk.  Because of 
this large size it is not recommended to down load the file nor will it be practical to pro-
vide it on 3.5-inch floppy disks.

Install Diego by following the steps as outlined on the material that comes with the disk.  

The software is packaged into an install executable bundle.  This means that one merely 
needs to double click on this file and the installation program will provide on-screen 
instructions on how to proceed.  Standard installation, provided by selecting all default 
choices, is highly recommended.  You may do a custom installation and place Diego into 
a special location on your hard drive, but this is only recommended for experienced users.

It will be necessary to reboot the computer after installing the software.  The program 
will not be usable until a reboot is done.  After reboot, the Diego Icon will be available on 
the computer desktop.  Double clicking on this Icon will launch the program.

Hardware Requirements for using Diego

Support Dongles and Cables

Diego version 2.10 can be used with various dongles and cable configurations.  This sec-
tion will describe the configurations and required hardware.  Note that although the 
FLS-2D can be used with Diego 2.10 for DCT-3 product support, that particular version of 
dongle is now considered obsolete and is no longer officially supported.

Minimum Hardware requirements

Processor 233 MHz

RAM 64 MB

Disk space needed 50 - 100 MB

Supported Operating systems Notes

Windows 95 Not supported

Windows 98

Windows NT 4.0 no USB support

Windows 2000 Professional version

Windows XP Professional version
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FLS-4S

The FLS-4S is a multi-purpose dongle that supports both DCT-3 and DCT-4 products.  In 
addition, it can be used as either a standard parallel port connected dongle or as a USB 
port connected dongle.  Support cables and flash adapters are available for all released 
products.

Figure 1: FLS-4S

FLS-4S Hardware Required

· 0080543 FLS-4S sales package - hardware included with sales package

FLS-4S dongle

ACF-8 power supply 

· 0730166 SCH-5 DCT-3 phone interface cable (MOD 10 RJ45 to Nokia DCT-3 
phone bottom connector)

· 0730218 XCS-1 DCT-4 interface cable (MOD 10 RJ45 to MOD 10 RJ45 and 
charger plug to specific phone model flash adapter)

· 0770xxx FLA-xx Point of Sales flash adapter (select version for specific phone 
model, refer to service manual for part number)

· Universal A/B USB cable for use with USB port (standard USB cable available 
from sources other than Nokia)

Figure 2: USB A/B Cable
 

 



RH-3
Service Software Instructions CCS Technical Documentation

Page 14  Nokia Corporation       Confidential Issue 1 06/2003

Cabling/ Configuration for FLS-4S Using Parallel Port

The following is an example of the necessary cable configuration for the FLS-4S.  To use 
the dongle on the USB port, add the USB A/B cable and connect to the computer USB 
port instead of the parallel port.

DKU-5F Flash Cable

The DKU-5F flash cable is designed for phones that have the Tomahawk connector on the 
bottom of the phone.  Through this cable, it is possible to flash the phone without the 
use of a flash adapter (FLA).  This cable is a direct computer USB port to phone Toma-
hawk connector.

The cable is a hybrid cable consisting of two systems multiplexed in one cable. One sys-
tem is the original RS-232 data module used by the DKU-5 cable. The second system is 
the flashing module from the FLS-4 cable. Drivers on the PC control multiplexing of the 
two systems.

Figure 3: DKU-5F Flash Cable

 1. FLA device 
2. XCS-1 cable 
3. Power supply 
4. FLS-4S 

 POS Set-Up 
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FLC-20 Flash Dongle and Cable

The FCL-20 is an inline flash dongle that can be used on either a USB port or a serial 
port.  It supports all current CDMA products by using the appropriate cable and/or flash 
adapter.  Refer to the specific service manual for details of required cables and flash 
adapters.

Figure 4: FLC-20 dongle (far left); Serial port cable (middle); USB port cable (far right)

Cable Configuration to support both DCT-3 and DCT-4 

The following configuration can be used to support both DCT-3 version phones and new 
version DCT-4 that have the Tomahawk connector.  This dual cabling configuration 
allows for simple cable connection to the appropriate phone without the need to change 
any physical connections on the computer.

Figure 5: Dual cabling configuration
After executing the Diego program, disable the auto-connection function (phone status 
box in lower left left-hand corner will be grey). Then, in Settings, select the port you wish 
to use.  Enable the auto-connection and the program will connect to the handset on that 
port.

 

 

 
DKU-5F  

  FLC-20 
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Installing Diego

Before installing check that:

· Ensure that if the computer supports administrator rights (typically on NT and 
Windows 2000 installations) that access is enabled for the user performing the 
installation.

· If a previous version of Diego has been installed, it may be necessary to first 
properly remove that program prior to installing the new version.  

· Once removal is performed, be sure to reboot the computer prior to continuing.  
See Uninstalling Diego for instructions on how to uninstall.

Installing:

· Insert the CD ROM disk into the computer drive.

· Access that drive and double click on Diego software package found on the disk.

· Follow the on-screen prompts to conclusion.

· Note that rebooting the computer will be necessary when completed.

Software Support Bundles:

· The Diego installation is a generic tool software load.  In order to support specific 
custom transceivers (customer specific phone models) it is necessary to also 
obtain Software Support Bundles.

· These bundles are created by CCS and made available by AMS on the Partners 
Web Page http://americas.partners.nokia.co .  This web page is password-con-
trolled so if you have not registered as a user, contact Nokia Central Service in 
Melbourne, Florida.

· Similar to the Diego installation, these packages are executable packages.  Just 
double click on the package and it will auto-install.  

· No re-booting of the computer is necessary.

Starting a Diego Session

Concepts

When referring to Diego, Product is the cellular phone attached to the computer.  More 
specifically, it is the particular type of phone.

Connection is the type of cable used to attach the phone and the port on the computer 
where it is attached.

The first time Diego is used, certain connection configurations must be made.  Subse-
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quent uses will rely on these selections and they will not need to be made again.

Initial Session with Diego and FLS-4S Dongle

It is necessary to configure in Diego the Virtual Port Connection the first time Diego is 
used.  The FLS-4 dongle uses Virtual port which eliminates the need to use the serial port 
as the FLS-2D does.  During the installation of the FLS-4 drivers (included in the Diego 
installation package), a virtual COM port is set to the next available COM port number.  
This port selection must be put into the Diego configuration.

Follow these simple steps:

Select My Computer desktop icon and click on the Virtual Port icon

Make note of the Virtual Port Assignment (COM 2 in this example).
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Next select "Add…" to create a new connection.

Select the Virtual COM port setting. Then press the Apply button.

You can now proceed with the normal initiation of a session.

Scanning for a Product

Many features of this program are product-specific.  Therefore it is necessary to config-
ure Diego for the product you will be working on at the beginning of the session.   

Scanning of the product can be done manually or automatically.  The default setting is 

 Note: COM port settings can 
only be entered or changed if 
the auto-connection feature of 
Diego is disable (as indicated 
by the grey Status box).   
 
To disable the auto-connect 
click on this icon in the tool 
bar: 
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automatic.  This setting can be changed to manual in the "settings" - "general" box.  In 
automatic mode Diego will automatically scan for a product at a periodic rate.  The rate 
is defaulted to every 10 seconds but can be changed to a different frequency in the setup 
menu.  

To manually scan for a product, click on the "Select" icon as noted above.

Using Components

When working with Diego, tasks are generally managed by specific software compo-
nents.  From the icons displayed on the left side of the screen, select the desired compo-
nent or task to be performed.

"Opening a component" is defined as opening a tool window within Diego.  When this 
window is opened, Diego also opens a task box for it, which includes component-specific 
menu items.

Functions

The following section describes the functions available and how to use them.  Note that 
each function is available for DCT-3 and well as DCT-4 model phones.  Some screens may 
be slightly different depending on model-specific requirements.

Administration Function

This is a new function available with Diego 2.10.  With this function an Administrator 
can create a user name and password, select settings and then be able to select which 
specific functions are to be displayed and which functions should be hidden.  (Once 
selected and applied, only those selections checked will be displayed.)  To change the 
selection, the Administrator must log in and enter the correct password.  

Selecting "Log In" located on the tool bar accesses the box illustrated above.  

If the password and/or user name is lost, re-installing the program resets the log in to 
"first time user" and will allow entry of a new user name and password.
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Administrator Selections

Once logged in as the Administrator, the above box can be accessed via the Settings 
selection on the tool bar.  Clicking on the box will toggle the checkmark.  Those items 
with a checkmark will be displayed and those without a checkmark are not displayed.  
This tab on the Setting box is not displayed if the user is not logged in as the Administra-
tor.  
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Flash Function

Figure 6: Flash screen for DCT-4 products  
Note that for DCT-3 model phones it is necessary to browse to the desired flash file and 
select it.  With DCT-4 models, Auto Pick is utilized and by selecting Flash it will automat-
ically select the most recent version of authorized flash software for that phone.

If the phone already has that version installed, the program will skip the flashing and 
only do a PRI update.  If the "Reflash image in phone" box is checked, it will re-flash the 
same version of software into the phone.  

Flash Select

If desired, it is possible to manually select the version of software to be loaded.  Still the 
Auto-pick file directs the selections provided.  In this way only acceptable, authorized 
versions can be selected.  It is not possible to select a version that is not specifically for 
the phone variant connected.
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Loading PRL

Loading a PRL into the phone is a manual function.  There currently is no auto-pick for 
PRL.  Click the Load PRL From File button to select the PRL to be loaded into each NAM 
available in the phone.  Note that if the phone configuration only allows NAM 1 it will 
not be possible to select and load a PRL into NAM 2.

When the desired PRL has been loaded, it is now possible to select the Write PRL To 
Phone button.  Prior to this, the button has been greyed out, thereby preventing selec-
tion.  Note that to successfully load a PRL into the phone requires both of these steps — 
loading and writing.

Phone Settings

This function allows the selection and editing of phone settings such as NAM configura-
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tion, IP address, and emergency numbers.  Although this function is available for DCT-3 
model phones, it may not be available to DCT-4 phones.  If it is not available, the follow-
ing warning will appear.

Since the phone software allows supports for this feature, the tool will automatically 
allow the phone settings screen and its functions to be accessed.

User Data Transfer

This function allows the transfer of all user data (such as phone book, call logs, SMS, 
timers, NAM data, and phone settings) into a new, same-model phone.  This is useful 
when providing a replacement phone due to a warranty issue.
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Note that the arrow will point to the current step and will automatically direct the 
sequence.  After the old phone has been saved, the program will wait until a new phone 
is detected and the Write Data to Phone button is pressed.

Phone Book Function

With this function it is possible to read, edit, and save either to the phone or a file 
located on the computer all phone book entries.  Note that it is also possible to save a 
phonebook from any Nokia CDMA version phone to the computer and then load that file 
into any other version of Nokia CDMA phone.
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Refurbish Function

Refurbish function, previously only available for DCT-4 model phones, is now also avail-
able for DCT-3 models.  The primary purpose of performing Refurb is to remove all user 
data and reset a phone to factory value settings.  When completed, the phone will be 
configured just like a new one right out of the box.  Care should be taken to not confuse 
this function with software upgrade or another feature in that customer data will be lost 
completely and will not be recoverable. 
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During the Refurb process, besides removing all user data, the phone software will be 
checked and updated if needed.  If the PRL is outdated, it is necessary to check "Replace 
PRL” button and then browse to the file with PRLs and select the desired version to be 
loaded.

Phone Model Upgrade

This is a new feature not previously available.  With Phone Model Upgrade, it is possible 
to automatically transfer key information (phonebook and NAM data) from one model of 
phone to a new different model. This function is similar to User Data Transfer.  The differ-
ence is that not all user data will be transferred — only phonebook and NAM.  One other 
stipulation is that a dongle that supports both DCT-3 and DCT-4 (e.g., the FLS-4S) must 
be used.
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After reading the old phone, disconnect it, change the cable plugged into the FLS-4S to a 
version for the new phone, and allow the program to make connection to the new phone.  
When connection is made (status box in lower left is green) select  the Write Phone 
Information button.  The new phone is now ready for activation with the network.

License Update Request Process

The FLS-4S is shipped in an operational state containing typically 50 flash licenses.  Once 
the FLS-4S has been registered with Nokia, by completing and sending the registration 
request form to Nokia Regional AMS, more licenses for the FLS-4S can be requested 
using the following process.  Make sure your FLS-4S is registered before requesting 
licenses, otherwise your request will not be processed.

First, a license request must be generated.  The program to perform this can be found 
under "File" on the main tool bar.  Select "Launch FL-X Licence Update Utility".  Follow 
the prompts to create the request data.
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Generate a license request

1. Connect the FLS-4S that requires more licenses to the PC Parallel or USB port.

2. Using the FLS-X License Update Utility, press the Request button on the left 
hand-side of the dialog, which will display a welcome screen.

3. Press the Next button.  The status bar at the bottom of the dialog will indicate 
that the application is searching for the FLS-4S and retrieving current license 
information from the FLS-4S.  This may take a few moments.  

4. This will result in the following screen:
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"Current Licenses" is the number of licenses remaining in the FLS-4S device.  "Request 
Licenses" is the number of licenses that may be added to the FLS-4S by a request to 
Nokia.

Note: The FLS-X License Update Utility will not allow a request to be generated that will 
increase the Current License count to greater than the License Limit.

5. Press the Next button.  This screen will prompt for a file to save the license 
request in, and/or send to printer to print the license request. 
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6. Select "Save to File" and/or "Send to Printer" and enter the filename and printer 
name as appropriate.  The default filename will be the FLS-X Serial Number with 
an extension of .req.

7. Press the Next button.  The FLS-X License Update Utility then processes the 
request and displays the resulting license request string.  This string will also be 
saved automatically to the specified filename and/or printed to the specified 
printer.

8. Send this license request to Nokia via an email to the regional AMS support 
office.

Processing a License Update Response:

1. Connect the FLS-4S for which that the license response was created for to the PC 
parallel port or USB port.

2. Using the FLS-X License Update Utility, press the Update button on the left 
hand-side of the dialog, which will display a Welcome screen.

3. Press the Next button.  Press the Load from file button and select the file that 
containing contains the license response.  This will be displayed on in the dialog 
box.

4. Press the Next button.  The FLS-X License Update Utility will process the license 
response and, if correct, will update the license in the FLS-4S.

Note: Once the license response has been successfully processed, a prompt will ask if the 
file containing the license response should be deleted, as it CANNOT be used again.  It is 
recommended that ALL the response files be deleted. This dialog box also contains a 
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check box. If this box is checked, the dialog box will not be displayed again. 

Uninstalling Diego

As mentioned in the Installing Diego section, it may be necessary or desirable to remove 
Diego.  Care must be taken to follow this procedure.  Failure to remove the program 
properly will cause misconfiguration of the computer’s registry.

Uninstalling Diego version:

• Go to the computer’s “Control Panel”, selectable from the Start button or the “My 
Computer” desktop icon.

• Select “Add/Remove Programs” icon.

• Select the Diego version to be removed, and click the Add/Remove button.

• Click on the OK button to begin the process of removal.

• Follow the on-screen instructions.

Be sure to reboot the computer when finished. 
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